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1. General introduction  
 
The most important design decisions influencing a building’s energy performance are made 
by the architect in the early phases of design. By introducing EcoDesigner, Graphisoft 
uniquely offers architects “green” tools at the conceptual phase, setting new standards in 
sustainable design.  
 
EcoDesigner is an add-on application for Graphisoft’s BIM software ArchiCAD 12. 
EcoDesigner allows architects to perform reliable energy evaluation of their virtual buildings, 
relying on building geometric analysis and accurate hour-by-hour weather data of the project 
location. This process requires relatively few physical material properties that can be provided 
with simple and straightforward user input. A reliable, certified calculation engine performs 
dynamic building energy evaluation and provides information on physical performance of the 
project’s applied constructions, yearly energy consumption, carbon footprint and monthly 
energy balance. 
 
This simple yet effective workflow makes energy evaluation just as easy to perform as 
generating a section or a 3D view from the virtual building model. To enable this real-time 
model energy analysis, the volume of input data has been reduced to a minimum: as a result, 
EcoDesigner is not designed to produce accredited energy analysis output suitable for official 
documentation according to local codes and code ratings. If applied in a professional manner, 
however, EcoDesigner is capable of producing results matching the accuracy of high-end 
energy calculation software. This article focuses on the advanced use of EcoDesigner, 
discussing topics beyond the scope of the basic information provided in the program’s User 
Guide. These techniques enable users to get the most out of the VIP Core calculation kernel 
(the same engine that is used in the StruSoft VIP-Energy software accredited for professional 
energy analysis), within ArchiCAD. 
 

2. Localized EcoDesigner contents – the .xml files 
 
EcoDesigner creates its own folder in the Add-Ons folder of ArchiCAD 12 when installed 
(C:\Program Files\Graphisoft\ArchiCAD 12 \Add-Ons\EcoDesigner). The version-specific 
localized content folder or folders (named with three-character nationality codes) are located 
here. EcoDesigner automatically loads its data from the folder corresponding to the localized 
version of ArchiCAD under which it runs. 
 
Each localized content folder contains the following six .xml files: 
 DefaultFillAssignments.xml 
 DefaultValues.xml 
 InternalUsages.xml 
 MaterialCatalog.xml 
 OpeningCatalog.xml 
 ShadingCatalog.xml 
 
In order to minimize the amount of necessary numeric user input, several input parameters are 
set within EcoDesigner by default or are listed in database catalogs. The .xml files shown 
above contain these default settings and catalogs. It is possible for users to modify the content 



of these files by simply text-editing them, in order to tailor the application exactly to their 
preferences and needs. The best software to use for this purpose is TextPad (available free for 
download from the internet). Microsoft Word is not suitable for editing .xml file content, as it 
changes the file format when the modified version is saved. NotePad may be used; however it 
is inconvenient as it displays the files in one continuous line.  
 
It is strongly advisable to save a copy of the original .xml files to a different folder prior to 
modifying them. Replacing the modified .xml-s with the originals allow the users to reset the 
changed settings and return to EcoDesigner’s default state. Users should also back up their 
own modified files before installing any hotfixes or upgrades to ArchiCAD or EcoDesigner, 
as the update process may replace customized .xml files. ArchiCAD must be closed and then 
restarted in order for the modifications to take effect.  
 

3. Folders used by EcoDesigner  
 
EcoDesigner manages data using three different folders:  

• \Add-Ons\EcoDesigner: see chapter 2. Localized EcoDesigner contents – the .xml 
files 

The locations of the other two folders (Temporary and Cache Folder) are specified 
individually under Options>Work Environment>Special Folders for every user. 

• Temporary Folder: When ArchCAD is launched, an EcoDesigner reference result file 
(.vdt format) is copied into this folder automatically. If an evaluation is carried out in 
EcoDesigner during the work session, a resultant temporary .vut file (VIP Energy file 
format that may be opened by the StruSoft VIP-Energy software for detailed analysis) 
is saved here, as well. Both the .vdt and the .vut files are needed by EcoDesigner to 
produce the Energy Evaluation Report, because the result file alone is meaningless 
without the reference data. 
The Temporary folder is also used to store the calculation error file (.err file format), 
that contains information about the cause of the failure in case of unsuccessful 
evaluation.  
The climate .xml file actually used is also copied here from the Cache Folder 

• Cache Folder: Climate files coming from the EcoDesigner folder or from the online 
weather database are managed here. 

 

4. Model Review  
 
In EcoDesigner, structures important for the energy evaluation are selected and grouped 
automatically. These selection sets are checked, changed and approved by the user via the 
Model Review palette. The program then obtains the relevant geometry data of selected 
structures and the building itself. 

4.1. Customizing the automatic building volume calculator and display  
 
The 3D Building Volume is the graphical representation of the building volume calculated by 
the Automatic Model Analysis. It may be visualized by clicking on the Show/hide Building 
Volume button of the Model Review Palette. However, while the Automatic Model Analysis 
subtracts the volume of the walls, slabs, columns and beams from the total building volume, 

http://www.archicadwiki.com/EcoDesigner�


these subtractions are not reflected in the display of the 3D Building Volume by default, since 
this would slow down processing time for larger projects. 

       
1. Default display of the 3D building volume 

 
EcoDesigner is capable of displaying the actual model the volume calculation is based on. If 
the values are changed from 0 to 1 in the following lines of the DefaultValues.xml file, 
turning on the originally disabled functions, the subtraction of the respective structure types 
become visible on the 3D Building Volume.  
 

  <DefaultValue Name="EcoDesignerData.CreateExtZones.TrimRoofs" Value="1" />  
  <DefaultValue Name="EcoDesignerData.CreateExtZones.TrimSlabs" Value="1" />  
  <DefaultValue Name="EcoDesignerData.CreateExtZones.SubstractBeams" Value="0" />  
  <DefaultValue Name="EcoDesignerData.CreateExtZones.SubstractColumns" Value="0" />  
  <DefaultValue Name="EcoDesignerData.CreateExtZones.SubstractSlabs" Value="0" />  
  <DefaultValue Name="EcoDesignerData.CreateExtZones.SubstractWalls" Value="0" /> 
 

2. The lines of the DefaultValues.xml that set the 3D building volume display 

       
3. 3D building volume display indicating the subtracted structural elements 

 

4.2. Changing Mark-Up colors 
 
The Model Review palette is based upon ArchiCAD’s Mark-Up Palette, using some of the 
applicable Mark-Up functions in simplified form for EcoDesigner. Therefore, some settings 
done on the Options>Element attributes>Mark-Up Styles dialog affect the appearance of the 
Model Review. 
 



     
 

4. Changing Mark-Up colors using the Mark-Up Styles dialog   
 
It is possible to alter the pen colors ArchiCAD uses to highlight the structure groups by 
changing the pens defined under Style Attributes on the Mark-Up Styles dialog. 
Note: the color assignments on the Model Review palette in picture 4 are used on all 
illustrations of this article. 
 
Important: In order to visualize the Model Review mark-ups, the Show Mark-Up Items 
checkbox must be checked on the Document>Set Model View>Model View Options dialog. 
 

4.3. Adiabatic walls of the building shell  
 
Adiabatic walls are walls of the building shell that separate heated spaces. They are called 
adiabatic due to the absence of heat transfer through them. Such walls (e.g. fire walls 
separating row-houses or other adjacent buildings) should be marked up as internal structures 
in order to get an accurate energy evaluation result. 
 

 
5. Marking up adiabatic walls   



 

4.4. Thermal insulated slabs separating internal and external spaces 
 
A common structural situation in architecture is the case of thermal insulated slabs separating 
heated and unheated spaces (e.g. floor slab below unheated attics; slabs above arcades, 
external spaces or unheated basements). To define such structures in EcoDesigner, mark up 
the slab as roof (orientation: upward) and set its surface to reflective using the Surface button 
next to the relevant entry of the Building shell elements list. 

     
6. Marking up thermal insulated slabs   

 

5. Location and Function 

5.1. Climate files 
 
Project location is defined by geographical coordinates and a custom name. Click Set City to 
access a predefined list of locations from the Cities attribute of ArchiCAD 12. If the building 
site is in one of the cities listed, it means that the necessary weather data is available within 
the default climate data file in the EcoDesigner folder (AddOns\EcoDesigner\WeatherData 
Cache.zip). The user may unzip this data file to access the package of text files in .vipclimate 
file format. Each text file starts with some general information concerning the monitored 
location and contains the hourly values of relevant weather information listed below, in a 
table-like format: 

 
VIP-Climate file rev 3.0 
Lock ID :12345 
Company name :Graphisoft EcoDesign 
Description :Nottingham 
Descriptionid :Nottingham-2007 
Year :2007 
Latitude :52.90 
Longitude :357.50 
No Leapyear 
 
Hour of year = HoY 
Day of year = DoY 
Date 
Hour of day = HoD 
Temperature = T oC 
Rel humidity = RH % 
Windspeed = WS m/s 
Solar radiation = SR W/m2 
 

7. General information paragraph of example climate file   



 
These data are provided by the NOAA-CIRES Climate Diagnostics Center in Boulder, 
Colorado, USA, from their Web site at www.cdc.noaa.gov . Users may study the table that 
belongs to their project’s location to verify its values against their observations or to look up 
extreme values to gain in-depth knowledge of the design environment.  

 
HoY DoY Date HoD T RH WS SR 
1 1 01/01 1 7.17 81.06 7.65 0.00 
2 1 01/01 2 7.26 81.06 7.65 0.00 
3 1 01/01 3 7.35 81.06 7.65 0.00 
4 1 01/01 4 7.44 81.06 7.65 0.00 
5 1 01/01 5 7.53 81.06 7.65 0.00 
6 1 01/01 6 7.62 81.06 7.65 0.00 
7 1 01/01 7 7.62 81.06 7.65 0.00 
8 1 01/01 8 7.61 81.06 7.65 65.55 
9 1 01/01 9 7.61 81.06 7.65 139.98 
10 1 01/01 10 7.61 81.06 7.65 186.77 
11 1 01/01 11 7.61 81.06 7.65 202.73 
12 1 01/01 12 7.60 81.06 7.65 186.77 
 

8. 12-hour data table excerpt of example climate files   
 
If the project location is not listed among the cities in the Cities dialog, then the relevant 
weather data must be downloaded from the Online Weather Database server. Once the 
weather data of a custom location is downloaded for a certain project, it is stored in the 
ArchiCAD Cache Folder (see Special folders) under the name WeatherDataCache.zip, in a 
folder entitled VIPWeatherData, so it remains available when opening another project. 
 

5.2. Grade level to project zero:  
 
Grade (pavement) level to Project Zero is the distance by which the pavement around the 
building is offset from the internal ground floor level. This setting influences the output of the 
Automatic Model Analysis; therefore you must call the Re-analyze model command for it to 
take effect. 
For sloping sites, the level of the pavement around the building varies. Enter a mean value for 
the various pavement levels in the corresponding numeric input field in the Location and 
Function dialog to get the most accurate Automatic Model Analysis result. Use the Model 
Review palette to fine-tune the selection sets, to mark up structures as exactly as possible. 
 

      
 

9. Underground structures of building on sloping site  

http://www.cdc.noaa.gov/�


 
Obviously, the more detailed the model, the more accurate selections can be made. If external 
walls are modeled using separate ArchiCAD wall elements for segments under and above the 
ground, for example, as with execution drawings, then they can be marked more accurately 
than on the draft model on pic.9. 
 

5.3. Façade shadings  
 
EcoDesigner is an energy evaluation tool; preparing detailed sun studies is beyond its scope at 
the present stage of its development. Therefore, instead of carrying out dynamic solar analysis 
and projecting the shadow mask to the building shell using cylindrical or parallel projection to 
produce real life simulation, EcoDesigner uses a simplified method to determine solar 
irradiation inflicted upon the building shell. This approach produces results much faster, while 
calculating the quantity of solar gains precisely enough for monthly and yearly energy 
evaluations.  

     
 

10. The Façade Shadings dialog and its available settings   
 
Shadows cast upon the building shell by external objects are taken into consideration by 
applying solar irradiation decreasing constants, which may be set for each orientation 
individually. Default numeric reduction percentage values linked to different levels of 
external shading are stored in the DefaultValues.xml file (see localized EcoDesigner 
contents). 
 

- <DefaultValue Name="ProjectData.FacadeShading.Shading.NotShaded" Value="5" />  
  <DefaultValue Name="ProjectData.FacadeShading.Shading.SlightlyShaded" Value="10" 
/>  
  <DefaultValue Name="ProjectData.FacadeShading.Shading.Shaded" Value="15" />  
  <DefaultValue Name="ProjectData.FacadeShading.Shading.VeryShaded" Value="30" />  
 

11. Solar irradiation reduction percentage default values  
 
The effect of shadows cast by projecting parts of the building shell on itself may be set by 
applying one of the predefined complexity profiles in the Façade Shadings dialog. Data 



describing the different levels of elevation complexity are stored in the ShadingCatalog.xml 
(see localized EcoDesigner contents). Horizontal edge angles and vertical fin side angles are 
used in pairs to define horizontal and vertical lines as the borders of the shadow masks on 
elevations facing each orientation separately.  
 

- <Shading Name="Average" ID="2" icon="2"> 
  <LimitTemperature>0.0</LimitTemperature>  
  <LimitEffect>0.0</LimitEffect>  
  <TotalShadeFactorReduction>0.0</TotalShadeFactorReduction>  
  <DirectShadeFactorReduction>0.0</DirectShadeFactorReduction>  
  <HorizontalUpperEdgeAngle>0.0</HorizontalUpperEdgeAngle>  
  <HorizontalLowerEdgeAngle>0.0</HorizontalLowerEdgeAngle>  
  <VerticalFin1Side1Angle>30.0</VerticalFin1Side1Angle>  
  <VerticalFin1Side2Angle>15.0</VerticalFin1Side2Angle>  
  <VerticalFin2Side1Angle>15.0</VerticalFin2Side1Angle>  
  <VerticalFin2Side2Angle>30.0</VerticalFin2Side2Angle>  
  <HighestWindVelocity>0.0</HighestWindVelocity>  
  </Shading>  
 

12. Default values describing the shading effect of average elevation complexity  
 

5.4. Activity  
 
It is possible for users to define and save custom Temperature and Heat gain profiles in 
addition to the ones offered in the standard EcoDesigner package. This may become 
necessary if the function of a certain project is so unusual that the default building activity 
profiles are unable to represent it, even if several are combined using the Multi-functional 
Building Dialog. Data describing building functions are located in the InternalUsages.xml file 
(see localized EcoDesigner contents). 
 

 

 
 
 
 
 



 
- <InternalUsage Name="Residential"> 
  <HotW>2</HotW>  
  <HotWLgh>0</HotWLgh>  
 
- <TemperatureProfile> 
  <Min>18</Min>  
  <Max>25</Max>  
  <WorkDay>0 0 0 0 0 0 22 22 22 22 0 0 0 0 0 0 
0 22 22 22 22 22 22 0</WorkDay>  
  <FreeDay>0 0 0 0 0 0 22 22 22 22 22 22 22 22 
22 22 22 22 22 22 22 22 22 0</FreeDay>  
  </TemperatureProfile> 

 
- <HeatGainProfile> 
  <WorkDay>3 3 3 3 3 3 3 4 4 4 3 3 3 3 3 3 5 
5 5 5 4 4 3 3</WorkDay>  
  <FreeDay>3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 
3 3 3 3 3 3 3</FreeDay>  
  </HeatGainProfile> 
 
  </InternalUsage> 

 

13. Profile parameters of the residential building function  
 
Copy-paste a complete text block that describes an activity in the InternalUsages.xml file, 
then rename it to create the custom profile. Pic.13. shows how the numeric values are used to 
describe internal temperatures and heat gains for every hour of a workday and of a non-
working day. Change these hourly values according to the specifications of the new activity, 
then save the modified .xml file. The newly created building function will appear in the local 
drop-down menu, along with the matching internal target temperature and heat gain graphs. 
 

6. Structures 

6.1. Editing multiple entries of the Building shell elements list  
 
Select the entry of the Building shell elements list that needs to be modified. Then add further 
entries to the selection by moving the pointer with the mouse without releasing the left mouse 
button, or by clicking on the entries while pressing the CTRL or the SHIFT key.  
 

 
14. Editing multiple entries of the Building shell elements list at once    

 
Use the function buttons that appear by the first selected line to modify properties of all 
selected list entries.  



6.2. Surface 
 
The properties of the building materials’ external surfaces influence the structure’s solar 
absorbance. Default absorbance percentage values linked to each available material are stored 
in the DefaultValues.xml file (see localized EcoDesigner contents). 

 
  <DefaultValue Name="Structure.Surface.SolarAbs.DarkColoredPlaster" Value="85" />  
  <DefaultValue Name="Structure.Surface.SolarAbs.MediumColoredPlaster" Value="50" />  
  <DefaultValue Name="Structure.Surface.SolarAbs.LightColoredPlaster" Value="8" />  
  <DefaultValue Name="Structure.Surface.SolarAbs.DarkStone" Value="65" />  
 

15. Examples of solar absorbance values linked to surface properties    
 
Users may alter the numeric percentage values, but may not change material names or add 
new materials to the Surface popup. 

6.3. Infiltration 
 
Infiltration refers to the air permeability of structures (unit: l/s,m2) within a selected structure 
group. Default infiltration settings are located in the DefaultValues.xml file (see localized 
EcoDesigner contents). 
 

  <DefaultValue Name="Structure.Infiltration.Airtight" Value="0" />  
  <DefaultValue Name="Structure.Infiltration.Low" Value="0.6" />  
  <DefaultValue Name="Structure.Infiltration.Average" Value="1.1" />  
  <DefaultValue Name="Structure.Infiltration.High" Value="1.6" />  
 

16. Values associated to the different levels of infiltration 
 
Users may edit the numeric values but may not change infiltration level names or add new 
levels to the Infiltration popup. 
 

6.4. Assigning physical material properties to ArchiCAD fills   
 
Material for EcoDesigner is not the same as an ArchiCAD material. While an ArchiCAD 
Material Attribute just governs surface appearance in 3D and photo-rendering, in 
EcoDesigner physical properties (thermal conductivity, density and heat capacity) are 
assigned to fills. An ArchiCAD fill is identified not by its appearance but its name, so 
identical looking fills with different names are distinguished by EcoDesigner. For example, if 
50% fill is used to represent all walls of the project, but they are actually made of several 
different materials in real life, depending on their function, then the 50% fill must be 
duplicated and saved with different names in order to enable the assignment of the various 
building materials.  
 
It is advisable to develop a template, using easy to identify fill names assigned to the 
matching material properties. These templates may later be transferred to other projects by 
using the Export/Import buttons of the Thermal Property Assignment dialog or by defining a 
custom DefaultFillAssignments.xml file (see localized EcoDesigner contents and Default 
material property to ArchiCAD fill assignments). 
 



6.5. Default material property to ArchiCAD fill assignments   
 
The DefaultFillAssignments.xml file (see localized EcoDesigner contents) assigns physical 
values for most fills in the base ArchiCAD template. Projects, however, may have fills that do 
not appear in the DefaultFillAssignments.xml file, but by modifying or adding to this list, it is 
possible to get immediate material matching without having to do any manual assignment 
within the EcoDesigner interface. 
 

  <FillAssignment FillName="Structural Concrete" MaterialGroupName="CONCRETE" 
MaterialName="REINFORCED CONCRETE W/ 1% STEEL" />  
  <FillAssignment FillName="Plaster" MaterialGroupName="PLASTERS AND RENDERINGS" 
MaterialName="GYPSUM PLASTER 1300" />  
  <FillAssignment FillName="Gypsum" MaterialGroupName="PLASTERS AND RENDERINGS" 
MaterialName="GYPSUM W/ SAND" />  
  <FillAssignment FillName="Batt Insulation" MaterialGroupName="THERMAL INSULATION-
MINERAL WOOL" MaterialName="MINERAL WOOL SOFT" />  
 

17. Excerpt from the DefaultFillAssignments.xml file 
 
The FillName is what you see in the Fills dialog or Attribute Manager within ArchiCAD. The 
MaterialGroupName and MaterialName must match values in the MaterialCatalog.xml file 
(see localized EcoDesigner contents and Customizing the Material Catalog). The default 
material assignments provided in EcoDesigner may be modified to create a custom material 
assignment template that supports the favorites, custom fills and pre-defined composites the 
user likes to work with. 
 

6.6. Customizing the material catalog   
 
The MaterialCatalog.xml file (see localized EcoDesigner contents) has materials listed in 
groups. The user can add new groups and materials or rename existing ones, but changes 
made here must also be done in the DefaultFillAssignments.xml file (see localized 
EcoDesigner contents and Default material property to ArchiCAD fill assignments). These 
modifications affect the manual assignments made in other project previously, as well. 
 

- <MaterialGroup Name="EXPANDED CLAY"> 
  <Material Name="LECA" ThermalConduct="1" Density="1800" HeatCapacity="800" />  
  <Material Name="LECA BLOCK" ThermalConduct="0.13" Density="330" 
HeatCapacity="880" />  
  <Material Name="LECA CB" ThermalConduct="0.12" Density="450" 
HeatCapacity="800" />  
  <Material Name="LECA WALL" ThermalConduct="0.21" Density="960" 
HeatCapacity="1050" />  
  <Material Name="LECA ISO" ThermalConduct="0.22" Density="960" 
HeatCapacity="1050" />  

  </MaterialGroup> 
 

18. Excerpt from the MaterialCatalog.xml file –The Expanded Clay material group 



 

6.7. U-value Calculator 
 
The U-value Calculator calculates the average heat transmission coefficient of materials and 
composite structures, based on a simplified algorithm that is used by most national standards. 
Some local conventions prefer to use the R value (Thermal Resistance Coefficient), which is 
the inverse of the U value. EcoDesigner supports the use of the R value in addition to the U 
value. 
 

 
 

19. Calculation algorithm of the U-value Calculator    
 
To include the effects of thermal bridges, delta U-values are added to the average U-values of 
structure group entries. The magnitudes of external and internal heat transfer coefficients and 
the delta U-value depend on the position of the evaluated structure relative to the thermal 
current. Default settings are offered within EcoDesigner (see pic.20.), but it is advisable to 
review and manually override the predefined values if the structural situation demands or if 
the standards for the project location are different. 
 
Position of structure 
relative to the thermal 
current 

EcoDesigner 
orientation 

External HTC. Internal HTC Thermal 
bridge effect 
(delta U) 

      Default settings available within EcoDesigner 
external wall 8 default points of 

the compass 
24 8 0,11 

roof upward 24 10 0,04 
basement wall underground 0 0 0 
      Further suggested settings 
slab below unheated 
attic 

upward 12 10 0,04 

slab above unheated 
basement 

upward 8 6 0,09 

slab above arcade upward 20 6 0,05 
Wall between heated 
and unheated internal 
spaces 

8 default points of 
the compass 

8 8 0,04 

 
20. Default heat transfer coefficients and delta U-values   

 
To correctly define thermal insulated slabs (see pic.20. for further suggested settings), define 
their surfaces as “reflective” on the Building shell elements list. 
Note: The result displayed on the Energy Evaluation Report is based on a dynamic calculation 
algorithm that is more accurate than the static method described above. The dynamic method 
determines the heat transmission through the building envelope structures at every hour 
throughout an entire year. 



 

6.8. Tempered floor area / Building volume 
 
In addition to the other data on the Structures tab page, the Tempered floor area and Building 
volume are also displayed here, as calculated by the Model analysis.   

 
 

21. Verification of building geometry data using ArchiCAD documentation tools 
 
Inaccurate element connections due to improperly constructed ArchiCAD models may 
produce open floor area polygons and, as a result, incorrect volumes may be generated by 
EcoDesigner. In this case the user has two ways to obtain the correct data: 

• Fix the incorrect element connections of the ArchiCAD model and then select the “Re-
analyze model” function button on the Model Review palette. 

• Modify the value of the Building volume via numerical input on the Structures tab 
page of the EcoDesigner dialog box. To do this, the user must calculate the Tempered 
floor area and Building volume manually. Naturally, ArchiCAD’s numerous helpful 
conventional documentation tools, such as dimension markers, zone stamps or fills 
with area markers turned on, help the user to obtain the necessary height and area data 
quickly, from which the building volume may easily be calculated. 

 

6.9. Internal heat storage mass 
 
There are three predefined options that describe the building’s Internal heat storage mass 
within EcoDesigner. The threshold values (total internal heat storage mass divided by the total 
floor area) for these categories are: 

• heavy-weight: > 400 kg/m2 
• medium: 250 – 400 kg/ m2 
• light-weight: <250 kg/ m2 

 



Within EcoDesigner, these predefined settings are linked to mean density values which are 
multiplied by the total volume of the interior structures (as displayed on the Structures tab-
page), providing the numeric input value to the calculation engine. 
 

6.10. Heat flow at the perimeters of structures that are in contact with the ground    
 
The Underground Insulation button on the Structures tab page is used to define the material 
and the thickness of thermal insulation of structures in contact with the ground. In 
EcoDesigner, these values are applied to Basement Floors and Floors on Ground, but not to 
Basement Walls, as their properties are defined in the Building Shell Elements List 
(Orientation: Underground) of the Structures panel.  
 
After selecting the underground insulation material used in your building from the Material 
Catalog, the insulation thickness data must be entered manually. In certain cases (see pic.22.), 
it is not easy to determine this thickness, as the thermal current passes through more than one 
layer of thermal insulation.  
 

a)   b)  
22. Thermal currents at the perimeter of structures in contact with the ground 

 
The user, first of all, should determine the critical thermal current, which travels the path of 
least resistance – through the least total thermal insulation, considering the different properties 
of the various thermal insulation materials. Pic.22.a. displays a frost resistant footing detail 
joint to a floor on ground. The floor has a 1,5m wide strip of thermal insulation around its 
perimeter to limit the thermal bridge effect. Relevant thermal currents are indicated by red 
arrows (numbered 1, 2 and 3). Even though currents 2 and 3 only pass through a single layer 
of thermal insulation, they also need to travel through a thicker layer of soil. Therefore current 
1 represents the path of least thermal resistance. For insulation thickness, the sum of the 
horizontal floor perimeter thermal insulation and the thermal insulation on the footing (d1 + 
d2) must be entered. 
 
The entered thermal insulation thicknesses divided by the thermal conductivities of the 
insulation materials equal the thermal resistances at the analyzed details. EcoDesigner uses 
these resistance values and the vertical displacements (indicated by ‘Z’ in Pic.22.a.) of the 
floors compared to the grade level of the project (derived from the Grade level to project zero 
settings and the floors’ positions relative to the project zero) to determine the linear heat 



transmission coefficients at each different relevant detail. The model analysis function 
calculates the perimeter lengths at each structure that is in contact with the ground (marked 
with green and red lines in Pic.22.b.). The matching linear heat transmission coefficients and 
length values are multiplied then eventually summed to obtain the effect of the most 
significant linear heat losses.  
 

7. Openings 

7.1. Customizing the Openings Catalog 
 
The OpeningCatalog.xml file (see localized EcoDesigner contents) has openings listed in 
groups. The user may add new groups or products based on data provided by manufacturers 
or according to local conventions. Naturally, the format of the newly created entries must be 
identical to the format of the existing entries. 
 

- <MaterialGroup Name="EXTERNAL DOORS"> 
  <Material Name="VINYL-PS-VINYL/SOLID" GlassShare="0" 
TotalSolarTransmittance="0" DirectSolarTransmittance="0" UValue="2.05" 
Infiltration="0.8" />  
  <Material Name="VINYL-PS-VINYL/GLAZED" GlassShare="15" 
TotalSolarTransmittance="66" DirectSolarTransmittance="53" UValue="2.11" 
Infiltration="0.8" />  
  <Material Name="WOOD-THERMAL INS/SOLID" GlassShare="0" 
TotalSolarTransmittance="0" DirectSolarTransmittance="0" UValue="1.5" 
Infiltration="0.8" />  
  <Material Name="WOOD-THERMAL INS/GLAZED" GlassShare="15" 
TotalSolarTransmittance="66" DirectSolarTransmittance="53" UValue="1.6" 
Infiltration="0.8" />  

  </MaterialGroup> 
 

23. Excerpt from the OpeningCatalog.xml file –some external doors  
 
Skylights are not supported by EcoDesigner12, but some basic types are included in the 
Openings Catalog in case the user wants to assign skylight parameters to window-type 
ArchiCAD elements. 
 

7.2. Shading devices 
 
The Shading device selection button appears when one of the Transparent openings list entries 
is highlighted. Shading devices with predefined physical properties may be applied to the 
selected entry. These default properties are stored in the ShadingCatalog.xml (see localized 
EcoDesigner contents) in a similar manner as the properties defining the different levels of 
elevation complexity (see Pic.12.).  
 

- <Shading Name="External Adjustable Louvre" ID="106"> 
  <LimitTemperature>22.0</LimitTemperature>  
  <LimitEffect>2500.0</LimitEffect>  
  <TotalShadeFactorReduction>90.0</TotalShadeFactorReduction>  
  <DirectShadeFactorReduction>90.0</DirectShadeFactorReduction>  
  <HorizontalUpperEdgeAngle>0.0</HorizontalUpperEdgeAngle>  
  <HorizontalLowerEdgeAngle>0.0</HorizontalLowerEdgeAngle>  
  <VerticalFin1Side1Angle>0.0</VerticalFin1Side1Angle>  
  <VerticalFin1Side2Angle>0.0</VerticalFin1Side2Angle>  



  <VerticalFin2Side1Angle>0.0</VerticalFin2Side1Angle>  
  <VerticalFin2Side2Angle>0.0</VerticalFin2Side2Angle>  
  <HighestWindVelocity>200.0</HighestWindVelocity>  
  </Shading> 
 

24. Default parameters describing a shading device type 
 
Most shading devices are not fixed; they are activated only when needed. EcoDesigner is 
capable of taking this dynamic effect into consideration by introducing three limit values that 
are compared to matching entries of the dynamic weather data to turn the shading devices on 
or off. 

• Limit Temperature defines the room temperature above which the shading device is 
activated. 

• If solar sensors are used to control the shading device, Limit Effect is set to define the 
solar radiation limit value in W/m2. 

• Highest Wind Velocity protects external shading devices from being damaged by 
strong winds. 

 
The Total Shade Factor Reduction value defines the percentage of total heat energy that 
reaches the interior space. The Direct Shade Factor Reduction value defines the percentage of 
heat energy that reaches the interior space due to solar irradiation. These two parameters must 
be equal for shading devices and are additional to the protective effects of the glass materials, 
as listed in the Openings Catalog.  
 
Horizontal edge angles and vertical fin side angles are used in pairs to define the horizontal 
and vertical borderlines of the shadow masks on the transparent Openings list entries.  
 
Users may alter the numeric values to better describe the specific product applied on the 
project, but may not change Shading Device names or create new entries. 
 

8. MEP systems and energy  

8.1. Hot water generation/Solar panel  
 
The target values set at Hot water generation only influence the hot water generated by solar 
panels, if there are any installed. Hot water generated by conventional means are set by 
default for each building activity profile (see: Activity) and are stored in the 
InternalUsages.xml file (see localized EcoDesigner contents and Pic.13.). 
 

- <InternalUsage Name="Residential"> 
  <HotW>2</HotW>  
  <HotWLgh>0</HotWLgh>  
 

25. Hot water generation related to activity type 
 
The HotW value defines the amount of energy (W/m2) that needs to be used to generate hot 
water for a unit Tempered floor area of the building. HotWLgh is an apartment-specific hot 
water generation value used in advanced VIP Energy calculations. HotWLgh should always 
be set to 0 in EcoDesigner. 
 



8.2. Yearly energy consumption of mechanical cooling   
 
It is possible to use EcoDesigner to determine the percentage of yearly energy consumption 
for Mechanical Cooling related to the total energy consumption of the building, even though, 
by default, this value does not appear separately on the Energy Balance Evaluation sheet. 
Once all parameters have been defined (including setting the “Cooling type” to Mechanical) 
go to “Energy sources and costs…” and set the Heating energy Source to Natural Gas and 
100% and the Other energy use to Natural Gas and 100%. Now run a preliminary evaluation. 
Since all other energy sources are set to Natural Gas the electricity requirement for 
Mechanical Cooling will appear under Energy consumption/electricity on the Energy Balance 
Evaluation sheet. Now go back to EcoDesigner and use the information obtained from the 
preliminary evaluation to enter the purchased energy source percentages in the Carbon 
Footprint Evaluation dialog correctly. Run another evaluation with the correct parameters to 
get the final Energy Balance Evaluation sheet. 
 

9. Customizing the appearance of the Energy Balance Evaluation sheet   
 
The graphical parameters of the Energy Balance Evaluation sheet are defined by the lines 
entitled Drawing Generator of the DefaultValues.xml file (see localized EcoDesigner 
contents). 
 

  <DefaultValue Name="DrawingGenerator.gNormalTextColor.Green" Value="103" />  
  <DefaultValue Name="DrawingGenerator.gNormalTextColor.Blue" Value="56" />  
  <DefaultValue Name="DrawingGenerator.gCaptionTextColor.Red" Value="0" />  
  <DefaultValue Name="DrawingGenerator.gCaptionTextColor.Green" Value="103" />  
 

26. Excerpt from .xml file describing the appearance of the Evaluation sheet  
 
It is not possible for the users to change the content of the evaluation sheet. Its appearance, 
however, may be customized. 
 
It is recommended that the following parameters should remain unchanged: 

• Page borders 
• Font sizes 
• Spaces 
• Column widths 
• Chart sizes 
• Carbon footprint image size 

 
Parameters that may be changed to customize the appearance of the report sheet: 

• Pen widths 
• Background colors 
• Text colors 
• Border colors 
• Energy group colors 
• Energy source colors 
• Bar chart background colors 
• Pie chart colors 
• Font name (type) 
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